
Introduction	to	NetSurveyor	802.11	Network
Discovery	Tool

NetSurveyor	is	an	802.11	(Wi-Fi)	network	discovery	tool	and,	as	such,
its	goal	in	life	is	to	gather	information	about	nearby	wireless	access
points	in	real	time	and	display	it	in	a	useful	way.	The	data	is	displayed
using	a	variety	of	different	diagnostic	views	and	charts.	Data	can	be
recorded	for	extended	periods	and	played-back	at	a	later	date/time.	Also,
reports	can	be	generated	in	Adobe	PDF	format.	Applications	for
NetSurveyor	include	the	following:

During	the	installation	of	a	wireless	network,	as	an	aid	in	verifying
the	network	is	properly	configured	and	antennas	are	positioned	at
locations	to	achieve	efficient	transmission	/	reception	--	that	is,	for
use	in	verifying	Wi-Fi	coverage	and	maximizing	beacon	signal
strength
Trouble-shooting	an	existing	network	or	wireless	environment	that	is
performing	poorly
Reporting	the	presence	of	Wi-Fi	networks	and	local	access	points
and	the	signal	strengths	of	their	beacons
Conducting	wireless	site	surveys	where	the	installer	is	interested	in
learning	about	the	coverage	of	a	new	or	existing	access	point,
roaming	capability,	presence	of	RF	interference	or	“dead	spots”,
and	optimum	location	of	access	points,	their	antennas	and	client
stations
In	a	secure	business	environment,	for	use	in	detecting	the	presence
of	rogue	access	points
As	a	learning	tool	to	help	understand	the	relationship	between
access	points	(BSSIDs),	wireless	networks	(SSIDs),	and	client
stations	(STAs)

NetSurveyor	is	distributed	freely	by	Nuts	About	Nets	LLC	both	as	a
convenience	to	network	engineers,	IT	administrators,	wireless
technicians	and	WiFi	users	and,	also,	as	a	way	of	drawing	attention	to
and	generating	interest	in	our	other	diagnostic	products	and	RF
analyzers.	NetSurveyor	can	be	downloaded	from



www.NutsAboutNets.com	and	www.PerformanceWifi.net.	You	may	also
distribute	NetSurveyor	as	long	as	that	is	done	without	charge	and	you
agree	to	the	terms	of	the	License	Agreement.
NetSurveyor	is	a	diagnostic	tool	that	falls	under	the	category	of	WiFi
Scanners	or	802.11	Network	Discovery	Tools.	The	best	known	in	this
category	is	NetStumbler	(www.NetStumbler.com).	A	discovery	tool
reports	the	Service	Set	Identifier	(SSID)	for	each	access	point	(AP)	it
detects,	along	with	the	channel	used	by	the	AP.	The	way	this	works	is
that	roughly	every	100	mSec	an	AP	sends	an	“I’m	here”	beacon	–	and
the	discovery	tool	(running	on	your	laptop	and	using	its	802.11	wireless
adapter,	also	known	as	a	station	or	STA)	picks-up	that	beacon	and	adds
the	SSID	to	its	list	of	known	access	points.	In	addition,	the	discovery	tool
reports	the	RSSI	(Received	Signal	Strength	Indication)	for	each	AP,
which	is	roughly	an	indication	of	how	close	the	AP	is	to	your	current
location	(i.e.	how	close	it	is	to	the	client	STA).	Just	to	be	clear,	the	RSSI
reflects	the	strength	of	the	beacon	as	received	by	the	STA	–	it	is	not	an
indication	of	performance.
We	know	there	are	other	choices	and	discovery	tools	available	–	so,	we
appreciate	your	interest	in	NetSurveyor	and	the	time	you’ve	taken	to
check	it	out.	And	we’re	sure	you	won’t	be	disappointed.	NetSurveyor
distinguishes	itself	from	other	tools	in	its	category	in	the	following	ways:

It’s	free.
In	addition	to	the	grid	that	repeatedly	updates	information	about
each	access	point,	there	are	6	graphical,	diagnostic	views
(discussed	elsewhere	in	this	document):	(1)	Timecourse	of	Beacon
Qualities	For	Each	Access	Point,	(2)	Differential	Display	of	Beacon
Qualities	for	Each	Access	Point	,	(3)	Usage	of	Each	of	the	802.11
b/g	Channels,	(4)	Timecourse	of	the	Usage	of	Each	of	the	802.11
b/g	Channels,	(5)	Heatmap	/	Waterfall	Chart	of	the	802.11	b/g
Channels	and	(6)	Channel	Spectrogram	of	the	802.11	b/g
Channels.	The	more	(and	different)	ways	you	have	at	looking	at	the
data	then	the	greater	the	chance	will	be	that	something	will	catch
your	eye	that	you	might	otherwise	miss	if	only	a	single	type	of	chart
were	used.
Generates	reports	in	Adobe	PDF	format	that	include	the	list	of
access	points	and	their	properties	along	with	images	of	each	of	the



6	diagnostic	charts.
Powerful	and	innovative	logging	and	recording	capability.	Other
products,	if	they	even	offer	a	recording/playback	feature,	usually
follow	the	“tape	recorder”	paradigm.	NetSurveyor	is	integrated	with
NetPlayer	(an	application	we	use	for	displaying	recorded	data	files).
NetPlayer	is	unique	in	that	it	shows	you	all	the	recorded	data	–	that
is,	you	do	not	press	a	‘play’	button	and	then	forced	to	watch	minutes
or	hours	of	data	scroll	by	in	the	hope	that	some	unusual	event	will
catch	your	eye.	NetPlayer’s	unique	approach	makes	reviewing
recorded	data	a	snap.
If	your	laptop	or	PC	has	multiple	wireless	adapters	installed	–	not	a
problem.	When	NetSurveyor	launches	it	detects	each	of	these	and
asks	you	to	choose	which	one	to	use	for	that	session.
Supports	most	all	wireless	adapters	–	that	is,	those	that	are
installed	with	an	NDIS	5.x	driver	(or	later).	This	would	include
wireless	adapters	running	on	Windows	2000,	XP	and	Vista.
Can	be	run	in	‘Demo’	mode	–	so,	even	if	you	don’t	have	a	wireless
adapter	attached	to	your	desktop	or	laptop	machine	you	can	still
experiment	with	the	application	to	see	whether	it	suits	your	needs.

Below	are	sample	screenshots	taken	of	the	various	diagnostic	views.
Each	of	these	are	discussed	in	greater	detail	elsewhere	in	this	document.



1.	Timecourse	of	Beacon	Qualities	for	each	access	point	(AP).



2.	Differential	display	of	Beacon	Qualities	for	each	access	point	(AP).



3.	Usage	of	each	of	the	802.11	b/g	channels.



4.	Timecourse	of	the	usage	of	each	of	the	802.11	b/g	channels.



5.	Heatmap	/	waterfall	chart	of	the	802.11	b/g	channels.



6.	Channel	Spectrogram	chart	of	the	802.11	b/g	channels.
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System	Requirements

System	Requirements:
PC	running	32-bit	Windows	2000/XP/Vista
802.11	b/g	wireless	adapter	installed	with	NDIS	5.x	drivers	(or	later)
Microsoft	.NET	Framework	version	2.0	(or	later)
CD-ROM	Drive	(for	installing	software)
a	minimum	of	300	MB	available	hard	disk	space

Suggested	Hardware	Requirements:
CPU:	Intel	Pentium	4,	1.2	GHz	or	faster
Memory:	512	MB
Hard	Drive:	1000	MB	free	space
Video:	32	MB	video	RAM
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Demo	Mode

NetSurveyor	supports	a	'Demo'	mode.	This	is	most	useful	when	you	do
not	have	an	802.11	wireless	adapter	installed	yet	still	wish	to	run	the
application	--	e.g.	either	for	evaluation	purposes	or	for	accessing
NetPlayer	to	playback	a	previously-recorded	data	file.	All	features	are
fully	functional	in	Demo	mode	--	the	one	difference,	of	course,	is	the	data
being	displayed	is	generated	by	a	built-in,	simulation	module	(rather	than
acquired	from	a	wireless	adapter).	When	NetSurveyor	is	launched	and
there	are	no	available	802.11	wireless	adapters	present	then	a	dialog	box
appears	asking	whether	you	wish	to	continue	running	the	application	in
'Demo'	mode	or	exit	the	application	(as	seen	above).
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Grid	ofAccess	Points

This	grid	of	local	access	points	is	updated	in	(semi)	realtime	--	that	is,
scans	are	performed	approximately	once	every	5	seconds.	The	data	for
each	column	is	briefly	described	below:

SSID

Service	Set	Identifier	--	a	human-readable	identifier
corresponding	to	a	wireless	network.	In	general,	there	could
be	multiple	BSSIDs	(i.e.	APs)	operating	on	the	same
wireless	network	and	using	the	same	SSID.	A	client	station
(STA)	can	choose	to	associate	with	any	of	the	BSSIDs	on
the	same	wireless	network	(though	performance	may	differ
for	a	variety	of	reasons).

BSSID
(MAC)

Basic	Service	Set	Identifiers	--	corresponds	to	the	access
points	(APs)	from	whom	beacons	were	detected.	For
infrastructure	802.11	networks,	the	BSSID	is	equivalent	to
the	MAC	address	of	the	AP.



Channel
An	access	point	is	configured	to	transmit/receive	on	a
particular	802.11	channel	(actually,	a	specific	frequency
range).	Under	802.11	b/g	there	are	14	possible	channels,	but
only	11	are	used	in	North	America	(i.e.	channels	1	-	11).

Beacon
Strength
(dBm)

Received	signal	strength	indication	(RSSI)	in	dBm.	This
measures	the	strength	or	power	of	the	"I'm	here"	beacon
transmitted	from	an	AP	approximately	every	100	mSec.	It	is
a	reflection	of	the	distance	between	the	AP	and	the	client
STA	and	is	*not*	an	indication	of	performance.

Beacon
Strength
(mWatt	x
10^6)

Same	as	above,	but	measured	in	mWatt	x	10^6.

Beacon
Quality
(%)

Converts	the	beacon's	signal	level	into	a	signal	quality	(0-
100%)	--	where	a	maximum	signal	is	assumed	to	be	-20
dBm	and	the	dissociation	signal	is	-85	dBm
(http://www.ces.clemson.edu/linux/dbm-rssi.shtml).	More
intuitive	than	reporting	a	RSSI	in	dBm	or	mWatt.

Beacon
Quality

Qualitative	measure	of	beacon	strengths:	where	"Excellent"
implies	>	-57	dBm,	"Very	Good"	implies	>	-67	dBm,	"Good"
implies	>	-71	dBm,	"Low"	implies	>	-81	dBm,	and	"Very	Low"
implies	>	-90	dBm.	Any	RSSI	below	-90	dBm	is	reported	as
"No	Signal".

Radio
Type

The	network	type	supported	by	the	access	point:	where
'DirectSequencing'	refers	to	802.11	b,	and	'OFDM24'	refers
to	802.11	g

Encryption
Whether	encryption	is	supported	and	enabled	on	the	access
point	--	'WEP'	implies	that	it	is,	'None'	implies	that	encryption
is	not	being	used.

Active
An	indication	of	whether	the	access	point	is	currently	active	-
-	that	is,	whether	a	beacon	for	this	access	point	was



detected	during	the	last	scan.
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Timecourse	of	Beacon	Qualities	For	Each	Access
Point

This	chart	displays	the	beacon	strength	of	each	access	point	as	a
function	of	time.	The	Y-axis	reports	the	signal	strength	as	a	signal
quality	(0	-	100%)	--	where	a	maximum	signal	is	assumed	to	be	-20	dBm
and	the	dissociation	signal	is	-85	dBm
(http://www.ces.clemson.edu/linux/dbm-rssi.shtml).	We	find	this	more
intuitive	than	reporting	a	RSSI	in	dBm	or	mWatt.	If	you	would	also	like	to
know	the	signal	strength	in	dBm	then	this	is	reported	in	the	grid	above
the	chart.



This	chart	can	become	difficult	to	read	when	there	are	many	access
points	--	because	there	are	so	many	lines.	Even	though	each	timecourse
is	color-coded	to	correspond	to	a	particular	AP,	it	becomes	hard	to	pick
out	a	single	AP	and	follow	its	timecourse.	To	this	end,	NetSurveyor
provides	a	couple	of	ways	to	aid	you	in	viewing	the	behavior	of	a	specific
AP	in	a	crowded	chart.	In	the	grid	above	the	chart,	by	simply	selecting
(i.e.	highlighting)	the	row	that	corresponds	to	a	particular	AP	then	the
corresponding	timecourse	is	highlighted	in	the	chart.	In	the	example
above	we	selected	the	BSSID	corresponding	to	'pharlink'	and	now	we
can	clearly	monitor	that	particular	timecourse.



When	you	right-click	the	mouse	button	in	the	area	of	the	grid	then	a
popup	menu	appears	with	two	choices:	Check	All'	and	'Uncheck	All'.	By
choosing	'Uncheck	All'	then	all	the	timecourse	lines	are	redrawn	as
dotted	lines	--	as	shown	above.	The	lines	are	drawn	as	thin,	solid	lines
when	the	checkbox	under	the	SSID	column	(in	the	grid)	is	checked.



Using	some	combination	of	'Checking'	and	'Selecting'	you	can	tailor	the
view	to	focus	on	the	access	points	you	are	most	interested	in	monitoring.
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Differential	Display	of	Beacon	Qualities	for	Each
Access	Point

This	chart	displays	the	current	beacon	strength	of	each	access	point
compared	with	an	earlier	snapshot.	The	current	beacon	strength	is
displayed	in	purple,	the	snapshot	in	light-blue,	and	the	difference	in	olive
green.	The	Y-axis	reports	the	signal	strength	as	a	signal	quality	(0	-
100%)	--	where	a	maximum	signal	is	assumed	to	be	-20	dBm	and	the
dissociation	signal	is	-85	dBm	(http://www.ces.clemson.edu/linux/dbm-
rssi.shtml).	We	find	this	more	intuitive	than	reporting	a	RSSI	in	dBm	or
mWatt.	If	you	would	also	like	to	know	the	signal	strength	in	dBm	then	this
is	reported	in	the	grid	above	the	chart.
The	Differential	display	can	be	used	to	view	small	(or	large)	perturbations
in	beacon	strength	over	time.	Here's	how	it	works	--	when	the	application
is	launched	then	a	'snapsot'	of	the	beacon	strengths	is	taken	--	these	are
the	light-blue	bars.	These	bars	are	static	and	do	not	change.	The	purple



bars	show	the	current	beacon	strengths,	and	the	olive	green	is	the
difference	between	the	snapshot	and	the	current	beacon	strength.

There	are	two	ways	to	update	the	snapshot	of	beacon	strengths	that	is
compared	against	the	current	beacon	strengths:	by	right-clicking	the
mouse	button	on	top	of	the	chart	then	a	popup	menu	appears	with	a
single	choice	--	'Refresh	Snapshot'.	By	selecting	'Refresh	Snapshot'	then
the	snapshot	is	updated.	Alternatively,	by	pressing	the	'Reset	Charts'
button	located	on	the	toolstrip	in	the	middle	of	the	display	then	all	the
charts	are	reset,	including	the	snapshot	used	for	this	view.
Finally,	by	checking/unchecking	BSSIDs	in	the	grid	(above)	you	can	tailor
this	view	to	better	focus	on	the	access	points	you	are	most	interested	in
monitoring.
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Usage	of	Each	of	the	802.11	b/g	Channels

This	chart	combines	the	access	points	by	channel	and	displays	a
summary	of	channel	usage.	As	in	most	of	the	other	charts,	the	Y-axis
reports	the	signal	strength	of	beacons	as	a	signal	quality	(0	-	100%).	In
this	view	the	data	for	each	channel	represents	a	collection	of	access
points	--	hence	the	signal	quality	as	displayed	along	the	Y-axis	is	often
greater	than	100%.	This	is	because	we	are	summing	the	signal	qualities
for	each	of	the	access	points	that	use	a	particular	channel.	One	thing
important	to	keep	in	mind	is	that	beacon	signal	strength	is	not	a	reflection
of	performance.
By	checking/unchecking	BSSIDs	in	the	grid	(above)	you	can	tailor	this
view	to	better	focus	on	the	access	points	you	are	most	interested	in
monitoring.	'Checked'	access	points	are	included	in	the	summed	beacon
quality	that	is	reported	for	a	particular	channel,	whereas	'unchecked'
access	points	are	not.
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Timecourse	of	the	Usage	of	Each	of	the	802.11	b/g
Channels

This	chart	combines	the	access	points	by	channel	and	displays	a
summary	of	channel	usage	as	a	function	of	time.	As	in	most	of	the
other	charts,	the	Y-axis	reports	the	signal	strength	of	beacons	as	a	signal
quality	(0	-	100%).	In	this	view	the	data	for	each	channel	represents	a
collection	of	access	points	--	hence	the	signal	quality	as	displayed	along
the	Y-axis	is	often	greater	than	100%.	This	is	because	we	are	summing
the	signal	qualities	for	each	of	the	access	points	that	use	a	particular
channel.	One	thing	important	to	keep	in	mind	is	that	signal	strength	is	not
a	reflection	of	performance.
By	checking/unchecking	BSSIDs	in	the	grid	(above)	you	can	tailor	this
view	to	better	focus	on	the	access	points	you	are	most	interested	in
monitoring.	'Checked'	access	points	are	included	in	the	summed	beacon
quality	that	is	reported	for	a	particular	channel,	whereas	'unchecked'



access	points	are	not.
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Heatmap	/	Waterfall	Chart	of	the	802.11	b/g
Channels

This	chart	combines	the	access	points	by	channel	and	displays	a
summary	of	channel	usage	as	a	Heatmap.	The	Heatmap	chart	is	also
known	as	a	"waterfall"	graph.	It	is	a	3-dimensional	representation	of	the
data,	where	the	X-axis	is	the	channel,	the	Y-axis	is	a	time	scale,	and	the
"Z-axis"	is	the	beacon	signal	quality	that	uses	color	scale.	Each
horizontal	line	in	the	Heatmap	chart	displays	beacon	signal	strength	(as	a
color)	as	a	function	of	channel	as	measured	over	the	time	period	of	one
scan.	That	is,	with	each	scan	(or	sweep)	a	new	row	is	added	at	the
bottom	of	the	Heatmap	chart.	The	color	legend	to	the	right	shows	that
stronger	signals	will	appear	red	and	weaker	signals	will	appear	blue.
By	checking/unchecking	BSSIDs	in	the	grid	(above)	you	can	tailor	this
view	to	better	focus	on	the	access	points	you	are	most	interested	in
monitoring.	'Checked'	access	points	are	included	in	the	summed	beacon



quality	that	is	reported	for	a	particular	channel,	whereas	'unchecked'
access	points	are	not.

When	right-clicking	the	mouse	button	on	top	of	the	chart	then	a	popup
menu	appears	with	a	single	choice	--	'Rescale	Heatmap...'.	By	selecting
'Rescale	Heatmap...'	then	a	small	dialog	box	appears	with	a	slider
control.	This	control	can	be	used	to	rescale	beacon	signal	strengths	to
better	spread	them	across	the	range	of	colors	that	are	used.	This	is
useful	when	beacon	signal	strengths	are	large	and	the	Heatmap	appears
mostly	red	or	when	beacon	signal	strengths	are	low	and	the	Heatmap
appears	mostly	blue.	Typically	one	would	remap	the	color	legend	to
better	make	use	of	the	colors	and	how	they	are	spread	across	the	highs
and	lows	of	beacon	signal	strength	values.



In	the	chart	above	we've	rescaled	the	color	legend	so	that	channels	1,	6
and	8	clearly	standout	as	being	more	heavily	used	than	other	channels.
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Channel	Spectrogram	of	the	802.11	b/g	Channels

The	Channel	Spectrogram	chart	is	a	3D	view	of	channel	usage	as	a
function	of	time.	Each	channel	is	represented	by	its	own	set	of	bar	graphs
--	the	X-axis	is	the	channel,	the	Z-axis	is	a	time	scale,	and	the	Y-axis
reports	the	signal	strength	of	beacons	as	a	signal	quality	(0	-	100%).	In
this	view	the	data	for	each	channel	represents	a	collection	of	access
points	--	hence	the	signal	quality	as	displayed	along	the	Y-axis	is	often
greater	than	100%.	This	is	because	we	are	summing	the	signal	qualities
for	each	of	the	access	points	that	use	a	particular	channel.
By	checking/unchecking	BSSIDs	in	the	grid	(above)	you	can	tailor	this
view	to	better	focus	on	the	access	points	you	are	most	interested	in
monitoring.	'Checked'	access	points	are	included	in	the	summed	beacon
quality	that	is	reported	for	a	particular	channel,	whereas	'unchecked'
access	points	are	not.
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Chart	Selection	and	Scan	Command

The	toolstrip	in	the	middle	of	the	display	contains	buttons	for	selecting
which	chart	to	view,	plus	additional	buttons	for	controlling	scan	behavior.

AP	Timecourse	button	selects	the	'Timecourse	of	Beacon	Qualities
For	Each	Access	Point'	chart
AP	Differential	button	selects	the	'Differential	Display	of	Beacon
Qualities	for	Each	Access	Point'	chart
Channel	Usage	button	selects	the	'Usage	of	Each	of	the	802.11	b/g
Channels'	chart
Channel	Timecourse	button	selects	the	'Timecourse	of	the	Usage
of	Each	of	the	802.11	b/g	Channels'	chart
Heatmap	button	selects	the	'Heatmap	/	Waterfall	Chart	of	the
802.11	b/g	Channels'	chart
Spectrogram	button	selects	the	'Channel	Spectrogram	of	the
802.11	b/g	Channels'	chart

Pressing	the	'Pause	BSSID	Scanning'	button	causes	scanning	to	stop.

Pressing	the	'Start	BSSID	Scanning'	button	causes	scanning	to
continue	(after	having	been	paused).

Pressing	the	'Reset	Charts'	button	resets	all	the	charts,	including	the
snapshot	used	for	the	'Differential	Display	of	Beacon	Qualities	for	Each



Access	Point'	chart.
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View	Commands

When	you	select	View	->	Adapter	Information...	from	the	main	menu
then	a	dialog	box	appears	that	displays	information	about	the	802.11
wireless	adapter	that	is	currently	being	used	by	NetSurveyor.



Typically	there	is	only	one	wireless	adapter	installed	per	machine	--	but
there	are	occasions	when	multiple	802.11	wireless	adapters	may	be
present.	In	that	case,	when	NetSurveyor	is	launched	a	dialog	box
appears	that	lists	the	available	802.11	wireless	adapters	--	and	you	would
choose	the	one	you	wish	to	use	for	that	particular	session.



The	View	menu	is	also	used	for	setting	your	sorting	preferences.	By
default	the	grid	of	local	access	points	is	sorted	alphabetically	using	the
SSID	property.	Alternatively,	you	can	sort	by	BSSID	(MAC),	channel	or
beacon	strength.	When	you	change	the	way	the	grid	is	sorted	there	may
be	a	slight	delay	-	the	new	sorting	preferences	will	take	effect	following
the	next	BSSID	scan.
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Data	Recording	and	Playback

NetSurveyor	features	a	simple,	yet	powerful,	Data	Recording	capability.
The	data	files	that	are	created	can	later	be	viewed	using	the	NetPlayer
application	(included	as	part	of	NetSurveyor's	installation/setup).	Please
note	that	when	recording	over	an	extended	period	of	time,	data	files	can
grow	to	be	quite	large	and	require	significant	disk	space.	So,	the
application	does	not	automatically	record	the	data	--	it	waits	for	you	to
select	Logging	->	Start	Recording	from	the	main	menu.	When	you	are
done	recording	and	do	not	wish	to	save	the	recorded	data,	then	select
Logging	->	Stop	from	the	main	menu.	If	you	are	done	recording	and	do
wish	to	save	the	data	then	select	Logging	->	Save	from	the	main	menu
and	a	SaveFile	dialog	box	will	appear	allowing	you	to	save	the	recorded
data	to	a	file	and	folder	of	your	choosing.
NOTE:	When	Logging	->	Start	Recording	is	selected	(and	before
recording	actually	begins)	the	application	first	checks	for	a	minimum	of
300	MB	of	free	disk	space	on	the	drive	on	which	the	NetSurveyor
application	was	installed.	This	would	allow	for	over	24	hours	of
continuous	recording.	If	sufficient	disk	space	is	not	available	then	a
warning	message	is	displayed.



NetPlayer	is	a	separate	application	that	we	use	to	view	data	files
recorded	by	NetSurveyor	--	it	is	included	as	part	of	NetSurveyor's
installation/setup	and	was	installed	at	the	same	time	as	NetSurveyor.
The	NetPlayer	application	can	be	launched	from	the	main	menu	by
selecting	File	->	Net	Player...
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Creating	Reports

NetSurveyor	has	a	powerful,	yet	simple-to-use,	report	generation
capability.	When	you	select	File	->	Create	Report...	from	the	main	menu
then	you	will	be	prompted	for	a	folder	and	filename	in	which	to	the	save
the	report	file.	An	Adobe	PDF	formatted	file	will	be	created	that	includes
the	grid	of	access	points	along	with	images	of	the	6	charts.	At	the	same
time,	Adobe	Reader	will	be	launched	so	you	can	verify	the	contents	of
the	report	you	just	created.



By	selecting	File	->	Open	Report...	from	the	main	menu	you	can	open
and	view	Adobe	PDF	formatted	reports	you've	created	(or	any	other	PDF
file).
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License	Agreement

Nuts	About	Nets,	LLC
NetSurveyor	802.11	Network	Discovery	Software
END	USER	LICENSE	AGREEMENT
Except	where	otherwise	noted,	all	of	the	documentation	and	software
included	in	the	NetSurveyor	package	is	copyrighted	by	Nuts	About	Nets,
LLC.
IMPORTANT-READ	CAREFULLY:	
This	Nuts	About	Nets,	LLC	End-User	License	Agreement	("EULA")	is	a
legal	agreement	between	you	(either	an	individual	or	a	single	entity)	and
Nuts	About	Nets,	LLC	for	the	NetSurveyor	802.11	Network	Discovery
software	product	identified	above,	which	includes	computer	software	and
may	include	associated	media,	printed	materials,	additional	computer
software	applications,	and	"online"	or	electronic	documentation
("SOFTWARE	PRODUCT").
By	downloading,	installing,	copying,	running,	executing,	or	otherwise
using	any	portion	of	the	SOFTWARE	PRODUCT,	you	agree	to	be	bound
by	the	terms	of	this	EULA.	If	you	do	not	agree	to	be	bound	to	the	terms	of
this	EULA,	then	please	do	not	download,	install,	accept	(for	example,	and
not	by	way	of	limitation,	by	checking	the	"I	DO	NOT	ACCEPT"	box	in
connection	with	this	EULA	at	the	beginning	of	the	software	download,
installation,	and/or	initial	execution	process),	or	permit	others	to
download,	install,	copy,	run,	execute,	or	otherwise	use	the	SOFTWARE
PRODUCT.

SOFTWARE	PRODUCT	LICENSE

The	SOFTWARE	PRODUCT	is	protected	by	copyright	laws	and
international	copyright	treaties,	as	well	as	other	intellectual	property	laws
and	treaties.	The	SOFTWARE	PRODUCT	is	licensed,	not	sold.

1.	GRANT	OF	LICENSE.	This	EULA	grants	you	the	following	rights:
a.	SOFTWARE	PRODUCT.	You	may	install	and	use	an	unlimited	number



of	copies	of	the	SOFTWARE	PRODUCT	on	computers,	including
workstations,	terminals	or	other	digital	electronic	devices
("COMPUTERS"),	provided	the	software	is	used	with	a	wireless	network
adapter	provided	to	you	by	Nuts	About	Nets,	LLC.
b.	No	Sale.	You	acknowledge	and	agree	that	this	copy	of	the
SOFTWARE	PRODUCT	has	been	licensed	to	you	pursuant	to	the	terms
and	conditions	of	this	EULA	and	that	such	copy	of	the	SOFTWARE
PRODUCT	has	not	been	sold	to	you.	In	addition,	you	acknowledge	that
this	copy	of	the	SOFTWARE	PRODUCT	is	not	subject	to	the	"first	sale"
doctrine	as	that	term	is	defined	in	United	States	Copyright	laws.
c.	Restrictions.	You	agree	(i)	not	to	copy,	transfer,	assign,	rent,	resell,
distribute	or	use	the	SOFTWARE	PRODUCT	other	than	as	expressly
authorized	in	this	EULA,	(ii)	not	to	remove	any	copyright	notice,
trademark	notice,	and/or	other	proprietary	legend	or	indication	of
confidentiality	set	forth	on	or	contained	in	the	SOFTWARE	PRODUCT,
and	(iii)	to	refrain	from	using	the	SOFTWARE	PRODUCT	for	any	other
purpose	other	than	as	expressly	authorized	in	this	EULA.

2.	DESCRIPTION	OF	OTHER	RIGHTS	AND	LIMITATIONS.
a.	Limitations	on	Reverse	Engineering,	Decompilation,	and	Disassembly.
You	may	not	reverse	engineer,	decompile,	recompile,	precompile,
disassemble,	hack,	port,	or	otherwise	attempt	to	discover	the	source
code	to	the	SOFTWARE	PRODUCT.
b.	Support	Services.	Nuts	About	Nets,	LLC	may	provide	you	with	support
services	related	to	the	SOFTWARE	PRODUCT	("Support	Services").	Any
supplemental	software	code	provided	to	you	as	part	of	the	Support
Services	shall	be	considered	part	of	the	SOFTWARE	PRODUCT	and
subject	to	the	terms	and	conditions	of	this	EULA.	

c.	Software	Transfer.	You	may	permanently	transfer	all	of	your	rights
under	this	EULA,	provided	you	retain	no	copies,	you	transfer	all	of	the
SOFTWARE	PRODUCT	(including	all	component	parts,	the	media	and
printed	materials,	any	upgrades,	and	this	EULA)	and	the	recipient	agrees
to	the	terms	of	this	EULA.	If	the	SOFTWARE	PRODUCT	is	an	upgrade,
any	transfer	must	include	all	prior	versions	of	the	SOFTWARE
PRODUCT.



d.	Termination.	Without	prejudice	to	any	other	rights,	Nuts	About	Nets,
LLC	may	terminate	this	EULA	if	you	fail	to	comply	with	the	terms	and
conditions	of	this	EULA.	In	such	event,	you	must	destroy	all	copies	of	the
SOFTWARE	PRODUCT	and	all	of	its	component	parts.

3.	INTELLECTUAL	PROPERTY	RIGHTS.
All	title	and	intellectual	property	rights	in	and	to	the	SOFTWARE
PRODUCT,	and	any	copies	you	are	permitted	to	make	herein	are	owned
by	Nuts	About	Nets,	LLC.	Furthermore,	you	agree	that	Nuts	About	Nets,
LLC	owns	all	right,	title,	interest,	and	intellectual	property	rights	in	and	to
the	SOFTWARE	PRODUCT	and	in	all	patents,	trademarks,	trade	names,
inventions,	copyrights,	know	how	and	trade	secrets,	and	any	related
applications	or	extensions,	relating	to	the	design,	manufacture,	operation
or	service	of	the	SOFTWARE	PRODUCT.

4.	EXPORT	RESTRICTIONS.
You	acknowledge	that	the	SOFTWARE	PRODUCT	is	subject	to	United
States	export	jurisdiction.	You	agree	to	comply	with	all	applicable
international	and	national	laws	that	apply	to	the	Software	Product	and/or
to	the	export	of	technical	data,	including	the	United	States	Export
Administration	Regulations,	as	well	as	end-user,	end-use,	and	destination
restrictions	issued	by	the	United	States	and	other	governments.	You
agree	that	you	will	not	export	or	re-export	the	SOFTWARE	PRODUCT	(or
portions	thereof)	to	any	country,	person	or	entity	subject	to	U.S.	export
restrictions.	You	specifically	agree	not	to	export	or	re-export	the
SOFTWARE	PRODUCT	(or	portions	thereof):	(i)	to	any	country	subject	to
a	U.S.	embargo	or	trade	restriction;	(ii)	to	any	person	or	entity	who	you
know	or	have	reason	to	know	will	utilize	the	SOFTWARE	PRODUCT	(or
portion	thereof)	in	the	production	of	nuclear,	chemical	or	biological
weapons;	or	(iii)	to	any	person	or	entity	who	has	been	denied	export
privileges	by	the	U.S.	government.

5.	DISCLAIMER	OF	WARRANTIES.
To	the	maximum	extent	permitted	by	applicable	law,	Nuts	About	Nets,
LLC	and	its	suppliers	provide	the	SOFTWARE	PRODUCT	and	any	(if



any)	Support	Services	"AS	IS	AND	WITH	ALL	FAULTS",	and	hereby
disclaim	all	warranties	and	conditions,	either	express,	implied	or
statutory,	including,	but	not	limited	to,	any	(if	any)	implied	warranties	or
conditions	of	merchantability,	of	fitness	for	a	particular	purpose,	of	non-
infringement,	of	lack	of	viruses,	of	accuracy	or	completeness	of
responses,	of	results,	of	ability	to	achieve	a	particular	result,	of	ability	to
execute	uninterrupted	or	error-free,	and	of	lack	of	negligence	or	lack	of
workmanlike	effort,	all	with	regard	to	the	SOFTWARE	PRODUCT,	and
the	provision	of	or	failure	to	provide	Support	Services.	THE	ENTIRE
RISK	AS	TO	THE	QUALITY	OF	OR	ARISING	OUT	OF	USE	OR
PERFORMANCE	OF	THE	SOFTWARE	PRODUCT	AND	SUPPORT
SERVICES,	IF	ANY,	REMAINS	WITH	YOU.
Specifically,	and	without	limiting	the	foregoing,	you	acknowledge	that
Nuts	About	Nets,	LLC	has	not	made	any	representations	or	warranties
with	respect	to	the	SOFTWARE	PRODUCT	or	the	functionality	thereof
and	has	made	no	representations	or	warranties	with	respect	thereto.	In
addition,	you	acknowledge	that	you	have	selected	the	SOFTWARE
PRODUCT,	and	that	Nuts	About	Nets,	LLC	makes	no	representations	or
warranties	with	respect	to	the	fitness	of	the	SOFTWARE	PRODUCT	for
any	purpose.

6.	NO	SUPPORT
Nothing	in	this	EULA	shall	obligate	Nuts	About	Nets,	LLC	to	provide	any
support	for	the	SOFTWARE	PRODUCT.	Nuts	About	Nets,	LLC	may,	but
shall	be	under	no	obligation	to,	correct	any	defects	in	the	SOFTWARE
PRODUCT	and/or	provide	updates	to	You	of	the	SOFTWARE
PRODUCT.	You	shall	promptly	report	to	Nuts	About	Nets,	LLC	any
defects	You	find	in	the	SOFTWARE	PRODUCT	to	aid	Nuts	About	Nets,
LLC	in	creating	improved	revisions	of	such	items.

7.	EXCLUSION	OF	INCIDENTAL,	CONSEQUENTIAL	AND	CERTAIN
OTHER	DAMAGES.
To	the	maximum	extent	permitted	by	applicable	law,	in	no	event	shall
Nuts	About	Nets,	LLC	or	its	suppliers	be	liable	under	any	theory	of
liability	for	any	special,	incidental,	indirect,	or	consequential	damages
whatsoever	(including,	but	not	limited	to,	damages	for	loss	of	profits	or



confidential	or	other	information,	for	business	interruption,	for	personal
injury,	for	loss	of	privacy,	for	failure	to	meet	any	duty	including	of	good
faith	or	of	reasonable	care,	for	negligence,	and	for	any	other	pecuniary	or
other	loss	whatsoever)	arising	out	of	or	in	any	way	related	to	the	use	of	or
inability	to	use	the	SOFTWARE	PRODUCT,	the	provision	of	or	failure	to
provide	support	services,	or	otherwise	under	or	in	connection	with	any
provision	of	this	EULA,	even	in	the	event	of	the	fault,	tort	(including
negligence),	strict	liability,	breach	of	contract	or	breach	of	warranty	of
Nuts	About	Nets,	LLC	or	any	supplier,	and	even	if	Nuts	About	Nets,	LLC
or	any	supplier	has	been	advised	or	should	know	of	the	possibility	of
such	damages.

8.	LIMITATION	OF	LIABILITY	AND	REMEDIES.
Notwithstanding	anything	to	the	contrary	contained	in	this	EULA,	and
without	limiting	any	other	rights,	remedies,	limitations,	or	restrictions	in
this	EULA	or	under	law,	Nuts	About	Nets,	LLC	will	not	be	liable	with
respect	to	any	subject	matter	of	this	EULA	under	any	contract,
negligence,	strict	liability,	or	other	theory,	at	law	or	in	equity,	for	any
amounts	aggregating	in	excess	of	amounts	paid	to	it	under	this
agreement	in	the	twelve	(12)	month	period	before	the	cause	of	action
arose.

9.	INDEMNITY
You	hereby	agree	to	indemnify,	protect,	defend	and	hold	Nuts	About
Nets,	LLC	harmless	from	and	against	any	and	all	claims,	losses	and
damages,	including	without	limitation,	reasonable	attorneys'	and	experts'
fees	and	disbursements,	(a)	which	may	at	any	time	be	asserted	against
Nuts	About	Nets,	LLC	by	any	party	for	Your	failure	to	perform	any	of	the
covenants,	agreements,	terms,	provisions	or	conditions	contained	in	this
EULA,	(b)	by	any	party	by	reason	of	Your	use	or	misuse	of	the
SOFTWARE	PRODUCT,	or	(c)	resulting	from	any	failure	by	You	to
comply	with	any	term	or	condition	of	this	EULA.	The	provisions	of	this
Section	10	shall	survive	the	expiration	or	earlier	termination	of	the	EULA.

10.	ENTIRE	AGREEMENT.



This	EULA	(including	any	addendum	or	amendment	to	this	EULA	which	is
included	with	the	SOFTWARE	PRODUCT)	is	the	entire	agreement
between	you	and	Nuts	About	Nets,	LLC	relating	to	the	SOFTWARE
PRODUCT	and	the	Support	Services	(if	any	or	many)	and	it	supersedes
all	prior	or	contemporaneous	oral	or	written	communications,	proposals
and	representations	with	respect	to	the	SOFTWARE	PRODUCT	or	any
other	subject	matter	covered	by	this	EULA.	To	the	extent	the	terms	of	any
Nuts	About	Nets,	LLC	policies	or	programs	for	Support	Services	conflict
with	the	terms	of	this	EULA,	the	terms	of	this	EULA	shall	control.
If	any	provision	of	this	EULA	shall	be	or	become	invalid,	illegal,	or
unenforceable	in	any	respect,	the	validity,	legality,	and	enforceability	of
the	remaining	provisions	contained	herein	shall	not	be	affected	thereby.
No	failure	or	delay	in	exercising	any	right	or	remedy	shall	operate	as	a
waiver	of	any	such	(or	any	other)	right	or	remedy.	Any	modification	or
waiver	to	this	EULA	must	be	in	writing	and	signed	by	both	parties.	The
language	of	this	EULA	shall	be	construed	as	a	whole,	according	to	its	fair
meaning	and	intent,	and	not	strictly	for	or	against	either	party,	regardless
of	who	drafted	or	was	principally	responsible	for	drafting	this	EULA	or	any
specific	term	or	conditions	hereof.	

Nothing	in	this	EULA	shall	be	deemed	to	create	any	type	of	agency,	joint
venture,	or	partnership	relationship	between	the	parties.	Neither	party
shall	have	any	right	or	authority	to	bind	or	obligate	the	other	in	any
manner	to	any	third	party.	In	the	event	of	any	legal	proceeding	between
the	parties	arising	out	of	or	related	to	this	EULA,	the	prevailing	party	shall
be	entitled	to	recover,	in	addition	to	any	other	relief	awarded	or	granted,
its	costs	and	expenses	(including	reasonable	attorneys'	and	expert
witness'	fees)	incurred	in	any	such	proceeding.

11.	QUESTIONS?
Should	you	have	any	questions	concerning	this	EULA	please	contact
Nuts	About	Nets,	LLC	via	email	at	NutsAboutNets@gmail.com	or	by
phone	at	425.881.6506.
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Contact	Us

The	NetSurveyor	application	software	was	created	and
copyrighted	by	Nuts	About	Nets,	LLC	2008

Nuts	About	Nets,	LLC
2855	152nd	Ave	NE,	Redmond	WA	98052

Tel:	425.881.6506

General	information	and	sales:	NutsAboutNets@gmail.com
Technical	Support:	NutsAboutNets@gmail.com

Web	Site:	www.NutsAboutNets.com
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